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Overview 

Novell GroupWise is a mail-server application used for mailing and messaging. The software also 

supports calendaring, task reminder, contacts and instant messaging. Many users like MS Outlook for the 

same activity. 

If you want to convert GroupWise to MS Outlook, now you don't have to loose your saved mails and other 

data.  

Stellar GroupWise to PST Converter enables you to convert GroupWise mailbox to PST file. The 

converted PST file can be directly opened into MS Outlook. All the items of GroupWise, i.e., e-mails, 

contacts, sent items, calendars, task reminders, attachments, etc. are transported to MS Outlook by help 

of the resultant PST file. 

The tool gives option to either convert all the mailboxes on the server or only mailbox of a desired user. 

You have to login using administrator to convert all the mailboxes into PST file. 

 

Preview of converted items is shown in a tree like structure in the converter application. The tool performs 

the conversion process smoothly without user intervention.  

What's new in this version? 

 Support for MS Outlook 2016 

Key Features 

 Supports conversion of single and multiple GroupWise mailboxes. 

 Converts e-mails, address book, calendars, notes, phone messages, discussion notes, document 

reference, etc. 

 Ensures accurate and reliable conversion. 

 Supports all versions of GroupWise client and MS Outlook. 

 Preview of the mail items is shown before conversion. 

 Advanced and Improved Login method. 

 Multilingual client support. 

 Option to save the converted file in PST, MSG and EML format. 

 Allows converting data from, all mailboxes, specific mailboxes, or specific folders on GroupWise 

Server.  

 Supports MS Outlook 2013/2010/2007/2003. 

 Supports GroupWise 6.0/6.5/ 7.0/8.0/GW-2012/GW-2014 



Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

 

Minimum System Requirements 

 Processor: Pentium Class 

 Operating System: Windows 10 / 8.1 / 8 / 7 / Vista / Windows Server 8 / Windows Server 3 

 Memory: Minimum 1 GB 

 Hard Disc: 50 MB of Free Space 

 MS Outlook: 2016 / 2013 / 2010 / 2007 / 2003 

 

To install the software, follow these steps. 

 Double-click StellarGroupWiseToPSTConverter.exe executable file to start installation. Setup - 

Stellar GroupWise to PST Converter dialog box is displayed.  

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar GroupWise to PST Converter Setup Wizard 

window is displayed. Click Finish. 

 

 Note: Clear Launch Stellar GroupWise to PST Converter check box to stop automatic launch of 

software.  



Launching the Tool 

To launch Stellar GroupWise to PST Converter in Windows 10: 

 Click Start icon -> All apps -> Stellar GroupWise to PST Converter  -> Stellar GroupWise to 

PST Converter  Or, 

 Double click Stellar GroupWise to PST Converter icon on the desktop. Or, 

 Click Stellar GroupWise to PST Converter tile on the home screen. 

To launch Stellar GroupWise to PST Converter in Windows  8.1 / 8: 

 Click Stellar GroupWise to PST Converter tile on the home screen. Or, 

 Double click Stellar GroupWise to PST Converter icon on the desktop. 

To launch Stellar GroupWise to PST Converter in Windows 7 / Vista: 

 Click Start -> Programs -> Stellar GroupWise to PST Converter -> Stellar GroupWise to PST 

Converter. Or, 

 Double click Stellar GroupWise to PST Converter icon on the desktop. Or, 

 Click Stellar GroupWise to PST Converter icon in Quick Launch. 

  



User Interface 

 Main User Interface 

 

 Menus 

 

 Buttons 

 

  



Main User Interface 

Stellar GroupWise to PST Converter has a very easy to use Graphical User Interface.  

 

After launching the program, you will see the main user interface as shown below: 

 

 

  



Menus 

File 

 

Connect to Mailbox 

Use this option to connect to a GroupWise 

mailbox(s). 

  

Save 

Use this option to convert and save selected 

mailbox items. 

 

Exit 

Use this option to close the application. 

 

 

View 

 

Log Report 

Use this option to view log report. 

  

 

 

Registration 

 

Register Stellar 

GroupWise to PST 

Converter 

Use this option to register 

the application. 

 

Transfer License 

Use this option to transfer 

the license of the registered 

software to another 

computer. 

  

 

 



Help 

 

Stellar GroupWise to PST 

Converter Help 

Use this option to view user help 

guide. 

 

Purchase Stellar GroupWise to 

PST Converter 

Use this option to buy Stellar 

GroupWise to PST Converter. 

 

View Support Section 

Use this option to visit support 

page of stellarinfo.com. 

 

Visit Knowledgebase 

Use this option to visit 

knowledgebase articles of 

stellarinfo.com. 

 

Submit Enquiry 

Use this option to submit enquiry 

to stellarinfo.com. 

 

About Stellar GroupWise to PST 

Converter 

Use this option to read information 

about Stellar GroupWise to PST 

Converter.  

 

 

 

  

https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter/buy-now.php
https://www.stellarinfo.com/support/
https://www.stellarinfo.com/support/
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/enquiry.php
https://www.stellarinfo.com/


Buttons 

The user interface contains buttons and options that help you access various features of the software with 

ease. 

 

 

Use this button to read information about the software. 

 

Use this button to purchase the software. 

 

Use this button to view help manual of the software. 

 

Use this button to save the converted PST file.  

 

Use this button to connect to GroupWise Mailbox Server. 

 

 

  



Ordering the Tool 

Click https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter.php to know more about Stellar 

GroupWise to PST Converter. 

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/groupwise-to-pst-

converter/buy-now.php 

Alternatively, click on Purchase button on the application tool bar to purchase the software online.  

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to register the software. 

  

https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter.php
https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter/buy-now.php
https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter/buy-now.php


Registering the Tool 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar GroupWise to PST Converter software. 

2. On Registration menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

 

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 



3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 

 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet 

connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its 

respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar GroupWise to PST Converter. In Register 

window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 

  

mailto:support@stellarinfo.com


Transfer License  

Stellar GroupWise to PST Converter allows you to transfer the license of the registered software to 

another computer on which you want to run the software with full functionality. This operation deactivates 

the product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Registration Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

 

On Source Computer: 

1. Run registered version of Stellar GroupWise to PST Converter software. 

2. In Registration Menu on Menu Bar, click Transfer License. 



 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File button 

to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 

location where you want to save the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is 

completed successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software 

anymore on this computer. 

 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 



 

2. Click Register to complete the activation process.  

3. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK. 

  



Updating the Tool 

There are periodical software updates for Stellar GroupWise to PST Converter. Software updates 

should be done to keep the software up-to-date. Updates can be a newly added functionality, a new 

feature, a new service or any other information that can be important for improvement. Update option in 

the application is capable of checking for the latest updates. This will check for both latest minor and 

major version available online. You can easily download minor version through the update wizard. 

However, the major version, if available, has to be purchased. While updating the software, it’s 

recommended to close all the running programs. Note that demo version can not be updated.  

To update the application, follow these steps: 

 Click on   button in application tool bar. Update Wizard opens.  

 Click Update button. A busy timer shows that updates are being searched. If it finds any new 

version, a message indicates the availability. If a message is displayed that no updates are 

available, click Cancel to close the wizard. 

 Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at https://www.stellarinfo.com/support/. 

For price details and to place the order, click  https://www.stellarinfo.com/email-tools/groupwise-to-pst-

converter/buy-now.php 

Chat Live with an Online technician at https://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at https://www.stellarinfo.com/support/kb/. 

Submit enquiry at https://www.stellarinfo.com/support/enquiry.php. 

E-mail to Stellar Support at support@stellarinfo.com. 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

 

USA (Tollfree- Pre Sales Queries) 

 

+1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales 

Support 
+31-208-111-188 

Worldwide +91-124-4326-777 

Email Orders  

 

  orders@stellarinfo.com 

 

    

https://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter/buy-now.php
https://www.stellarinfo.com/email-tools/groupwise-to-pst-converter/buy-now.php
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/
https://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com?
mailto:orders@stellarinfo.com?subject=Purchase%20Order


Connect to GroupWise Server 

You need to connect to the GroupWise server to access mailbox items in Stellar GroupWise to PST 

Converter for conversion. 

 

To convert GroupWise mailbox to a PST file,  

 

1. Run Stellar GroupWise to PST Converter. Connect to GroupWise Server dialog box is displayed, 

by default. You can click on File ->Connect to Mailbox or click  on to open the 'Connect' 

dialog. 

2. In Connection Option section:  

 Convert  single GroupWise mailbox to PST file: Choose this option if you want to 

convert mail items from single GroupWise mailbox.  

 Convert  all GroupWise mailboxes to PST files:  Choose this option if you want to 

convert mail items from multiple, or all GroupWise mailboxes. 

 

  

 

Single Mailbox Connection Options Screen 

 



 

3. In the GroupWise Server Information section: 

 If you have selected Convert  single GroupWise mailbox to PST file in connection, then in the 

GroupWise Server Information section: 

o In Mailbox Name: Type the required 'GroupWise mailbox name'.  

o Password: Type user password that is used by the GroupWise user for login.  

o Address:Type the IP address of server. 

o Port: Type port number to identify the senders and receivers of messages. 

 If you have selected Convert  all GroupWise mailbox to PST files in connection, then in the 

GroupWise Server Information section: 

o Proxy User Name: Type the required 'GroupWise administrator name'.  

o Password: Type user password that is used by the GroupWise administrator 

user for login.  

o Address:Type the IP address of server. 

o Port: Type port number to identify the senders and receivers of messages. 

 

 

 

All Mailboxes Connection Options Screen 

   
4. Click OK button to continue. 

  



Preview Mailbox Items 

Once the GroupWise server is connected, the preview window is populated with the mailbox items. 

Preview window is a three pane structure. Left pane shows the connected mailbox(es) and folders as a 

tree, Top-right pane shows the content of the selected folder as a list. When any item in this list is clicked, 

it is shown in the bottom-right pane.  

 

  

 

Preview Window  

When Single mailbox is Connected 

 

To preview a mail item 

1. In the left pane, click on the required folder. All the items in the folder are displayed in the top-

right pane. 

2. Click the desired item in the top-right pane.  Preview is shown in the bottom-right pane.  

3. Scroll in the bottom-right pane to preview the mail item. 

 



  

 

Preview Window  

When all mailboxes are Connected 

  



Convert and Save the Mailbox 

After the GroupWise mailbox is connected and shown in the application, you can convert and save it. 

Stellar GroupWise to PST Converter gives three options for conversion.  

To convert and save the mailbox 

1. After connecting to GroupWise server, mailbox items are shown in the preview window. 

2. Check a mail item (mailbox, folder or subfolder) in the left pane.   

3. On the File menu, click Save. Or, click  on the toolbar. 

 

 

Converting and Saving the Mailbox  

4. In the Save Options window, select a format for conversion of the mailbox. Stellar GroupWise to 

PST Converter supports PST, MSG and EML formats. 

5. Click OK. 

6. If you have selected PST file option, an option dialog box is prompted, showing two options for 

saving the converted PST file. Note that, these two options in the dialog are only shown if you 

have connected using Convert  single GroupWise mailbox to PST file option. 

 Choose Create new PST to save the converted mailbox in a new PST file. 



 Choose Append to existing PST to merge the converted mailbox in an existing PST file. 

 Click Browse to specify a location to save the file. 

 

 

Save Options for PST File 

7. Click OK. 

To save converted mails to MSG or EML format:  

1. After connecting to GroupWise server, mailbox items are shown in the preview window. 

2. Check a mail item (mailbox, folder or subfolder) in the left pane. 

3. Click Save icon on toolbar, or select Save option from File Menu. 

4. In Save Mailbox Option dialog box, select either MSG or EML radio button and click OK. 

5. In Stellar GroupWise to PST Converter dialog box, click Browse and select the location where 

you want to save the converted file. Click OK. 

  



View Log Report  

You can view, clear and save log report of activities performed in Stellar GroupWise to PST Converter.  

 

To view log report 

 On the View menu, click 

Log Report option. 

 In the Log Report window,  

o Click General Details 

tab to view general 

report. 

o Click Saved Data 

Details tab to view log 

of the saved 

mailboxes.  

 

To save log report 

 In the Log Report window, 

click Save Log button. 

 In the Browse For Folder 

dialog box, specify the 

destination folder to save 

log file. Click OK.  

 

To clear log report 

 In the Log Report window, 

click Clear Log button. 

 

 

  



View Saved Data Details 

You can view, clear and store 'Saved data details report' using Stellar GroupWise to PST Converter. 

 

To view log report 

 On the View menu, click 

Log Report option. 

 In the Log Report window, 

click Saved Data Details 

tab. All the mailboxes 

'converted previously' are 

shown as a list.  

 

To save log report 

 In the Log Report window, 

click Save Log button. 

 In the Browse For Folder 

dialog box, specify the 

destination folder to save 

log file.  

 In the Save as Type 

option, specify a type (.txt, 

.CSV, or .html).  

 Click OK.  

 

To clear log report 

 In the Log Report window, 

click Clear Log button. 

 

 

 

 

  



FAQs 

1. What does demo version of the software do? 

Demo version of the software shows preview of all data but after saving as PST file, when you 

open the saved mail items: 

 If you open a e-mail: 

o In the 'Sender information', To:, cc:, and bcc: is not shown. 

o In 'attachment', attachment name will be displayed but will show as blank when 

opened. 

o 'Subject' of the mail will be shown. 

o 'Mail body' will be shown.  

 If you open the Calender: Location information will be shown as demo; Current date will 

be shown for Start date and End date.   

 In the Task: Owner will be demo; Current date will be shown for Start date and End date. 

 In the Contacts: Name of the contact will be shown; e-mail Id will not be shown; in place 

of address 'demo' will be shown.   

You can save all the converted data in the registered version. To save the converted mailbox, you 

need to purchase and register the software. 

2. Can I convert address book and New Group in GroupWise? 

Yes, you can convert address book into a PST file. New Group will be shown as Distribution List 

in the converted PST file. 

3. How much time will the software take to convert mailbox to a PST file? 

The time taken in converting mailbox items is dependent on the amount of the items.  

4. Does Stellar GroupWise to PST Converter makes any change to my mailbox while 

conversion? 

No. It only creates a PST, MSG or EML file as selected by the user. Original GroupWise mailbox 

is kept as it is. 

5. Does the software provide support for multiple languages? 

          Yes, it supports multilingual clients in different languages. 



Legal Notices 

Copyright 

Stellar GroupWise to PST Converter software, accompanied user manual and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright 

laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar 

Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use 

of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar GroupWise to PST Converter® is a registered trademark of Stellar Information Technology Private 

Limited. 



 

Windows Vista®, Windows 7®, Windows 8®, Windows 8.1®, Windows 10®, Windows Server 2003®, 

Windows Server 2008 are registered trademarks of Microsoft® Corporation Inc. 

 

All Trademarks Acknowledged. 

 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement - Stellar GroupWise to PST 
Converter 

Stellar GroupWise to PST Converter 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar GroupWise to PST Converter. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar GroupWise to PST Converter with which this License is included, you may return 

the complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar GroupWise to PST Converter. For purposes of this License, if you have a valid single-user license, 

you have the right to use a single Licensed Copy of Stellar GroupWise to PST Converter. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar GroupWise to PST Converter equal to the number of copies 

indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar GroupWise to PST Converter may either be used by a single person or 

used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. This is not a concurrent use license. 

All rights of any kind in Stellar GroupWise to PST Converter, which are not expressly granted in this 

license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. 

You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative 

works based on Stellar GroupWise to PST Converter nor permit anyone else to do so. You shall not make 

access to Stellar GroupWise to PST Converter available to others in connection with a service bureau, 

application service provider or similar business nor permit anyone else to do so. 

http://www.stellarinfo.com/


Warranty Disclaimers and Liability Limitations 

Stellar GroupWise to PST Converter and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar GroupWise 

to PST Converter must be thoroughly tested with non-critical data before there is any reliance on it and 

you hereby assume the entire risk of all use of the copies of Stellar GroupWise to PST Converter covered 

by this License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no 

event does Stellar authorize you or anyone else to use Stellar GroupWise to PST Converter in 

applications or systems where its failure to perform can reasonably be expected to result in a significant 

physical injury or in loss of life. Any such use is entirely at your own risk and you would not hold Stellar 

responsible for any and all claims or losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high speed bulk data erasure & 

generate erasure certificates for audit trail purpose. 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.php


BitRaser supports 24 International data erasure standards. More Info >> 

 

For more information about us, please visit www.stellarinfo.com. 

http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
https://www.stellarinfo.com/

